GPS System 500

User Manual / Getting Started with SKI-Pro

Version 2.0
English
Congratulations on your purchase of Leica Geosystems SKI-Pro Software

In order to use this software correctly and reliably, you must follow the instructions given in this user manual and/or in the on-line help system. You must also adhere to the directions given in the user manual for the product with which you are using the software.

The rights and responsibilities accruing in respect to Leica Geosystems as a result of acquisition of the software are set out in the Leica Geosystems Software Licence Agreement.

All of the instructions and directions required for technical specialist to use the software are included in this user manual, which is only available in certain languages.
Product Identification

The software version of your copy of SKI-Pro is written on the CD-ROM label. The License Number is given on the SKI-Pro Software Licence Agreement. Enter the software version and licence number in the spaces provided below and always refer to this information when you need to contact agency or authorized service workshop.

Software Version: ____________________
Language: ____________________
Licence Number: ____________________

Technical Support

Technical Support is provided by Leica Geosystems worldwide network of representatives. We are represented in almost every country in the world. A representative directory is available at:

www.leica-geosystems.com
Symbols used in this manual

Symbols used in this manual have the following meanings:

**DANGER**
Indicates an imminently hazardous situation which, if not avoided will result in death or serious injury.

**WARNING**
Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

**CAUTION**
Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury and/or appreciable material, financial and environmental damage. The symbol is also used to alert against unsafe practices.

Important paragraphs which must be adhered to in practice as they enable the product to be used in a technically correct and efficient manner.
Chapter Overview

Introduction

Installation

An Overview of SKI-Pro

Quick Tour I - Real Time

Quick Tour II - Post-Processing

Quick Tour III - Format Manager

Quick Tour IV - GIS/CAD Export
Contents

Introduction .......................................................... 7
  Licence Agreement and Support .................................. 8
  Software Protection .................................................... 8

Installation ............................................................ 10
  Installation Instruction ................................................ 11
  Uninstall SKI-Pro ..................................................... 12
  Starting and exiting SKI-Pro ....................................... 13

An Overview of SKI-Pro .......................................... 14
  SKI-Pro components ................................................ 14
  Software Navigation Tools ........................................ 21
  Views ........................................................................ 23
  Accessing the On-line Help ....................................... 26

Quick Tour I - Real Time ........................................... 28
  Lesson One - Starting a Project and Importing Raw Data ......................................................... 29
  Lesson Two - Exploring the View/Edit Component ...... 34
  Lesson Three - Exporting Coordinates to a Custom ASCII File ..................................................... 36

Quick Tour II - Post-Processing ............................... 39
  Lesson One - Starting a Project and Importing Raw Data ................................................................. 40
  Lesson Two - Processing Baselines .............................. 43
  Lesson Three - Creating a Coordinate System ............. 50
  Lesson Four - Importing an ASCII File .......................... 52
  Lesson Five - Calculating Transformation Parameters ..... 56
  Lesson Six - Using a Coordinate System with a Project ...................................................................... 59
  Lesson Seven - Exporting Coordinates to an ASCII File ..................................................................... 61

Quick Tour III - Format Manager ............................... 64
  Lesson One - Creating a Format Template File .......... 64
  Lesson Two - Uploading a Format Template File to the Sensor ......................................................... 68

Quick Tour IV - GIS/CAD Export ............................... 69
Welcome to SKI-Pro, Static-KInematic-Professional GPS software for post-processing and management of GPS data. SKI-Pro is the complete GPS office software package that accompanies Leica Geosystems GPS System 500 Hardware.

What is SKI-Pro
Leica Geosystems’s SKI-Pro software is a comprehensive, automated suite of programs for GPS surveying including post-processing and support of real-time measurements.

It’s functionality includes:

- Data import
- Data management
- Data processing
- Network adjustment
- Datum transformation
- Data export

SKI-Pro user interface (graphical view)
Read the Software License agreement carefully before opening the package containing the installation CD-ROM.

**Software Protection**

Part of SKI-Pro is not protected and may be used without the software protection key (dongle). The unprotected part contains:

- Satellite Availability
- Data Import
- RINEX Export
- ASCII Import / Export
- Project Management
- Coordinate Set Management
- Coordinate System Management
- Sensor Transfer
- View and Edit
- Codelist Management
- Antenna Management
Software Protection, continued

The protected options are available individually and can be accessed by using the software protection key only. The protected options are:

- Data Processing
- Datum and Map
- Adjustment
- RINEX Import
- GIS / CAD Export

If you are installing SKI-Pro all options will be installed automatically but the protected options are accessible only if the software protection key is connected to the parallel port of the computer and if the purchased options have been activated on the protection key.
Installing SKI-Pro is a simple process. This brief chapter explains everything you need to know regarding installation.

**System requirements:**
The computer and system software you intend to use with SKI-Pro must meet the following minimum requirements. Note that SKI-Pro works best with the recommended requirements.

The operating system must be one of the following:
Windows 95, Windows 98, Windows 2000 or Windows NT 4.0 (or later).

Minimum Hardware requirements:
- PC with Pentium processor 90 Mhz
- 16 MB RAM
- 100 MB free space on harddisk (for typical installation)
- RS232 COM port
- Parallel Port (for software protection key)
- 1.4 MB 3.5 inch disk-drive
- Mouse installed

Recommended Hardware requirements:
- PC with Pentium processor 200 Mhz or faster
- 64 MB RAM
- 300 MB free space on harddisk
- RS232 COM port
- Parallel Port (for software protection key)
- CD-ROM drive
- Mouse installed

**Before you install:**
Ensure that your computer and software conform to at least the minimum requirements as outlined above.
SKI-Pro requires at least 50 MB of free disk space. The programs on the installation CD are compressed and will be expanded during installation.
Installation Instruction

SKI-Pro is delivered on a CD-ROM. If you do not have a CD-ROM drive you can order the installation on floppy diskettes separately.

To install SKI-Pro from CD-ROM:
- Insert the CD-ROM labelled “GPS System 500SW”. The install shield will start automatically and guide you through the installation process.

During the installation you are given the following option to install: Typical or Compact. If you choose Typical all components including the optional components will be installed. This option is recommended in most cases. Choose Compact only if you are always using SKI-Pro without the software protection key (dongle) and want to save disk space.

To install SKI-Pro from floppy diskettes:
- Insert the floppy diskette labelled Disk 1.
- From the Windows™ Start bar, click Run.
- Type a:\setup. The Setup program prompts you through the installation process. Follow the instructions on the screen.

Older version of SKI-Pro already installed
If you have an older version of SKI-Pro already installed on your computer all database information such as Projects, Coordinates Sets and Coordinate Systems will be updated automatically.

Database information from SKI 2.3 or earlier will NOT be updated automatically. To update SKI 2.3 (or earlier) Projects you can either re-import raw data and process them again or you can import final coordinates or baselines via SKI ASCII files.
Uninstall SKI-Pro

Do not delete any program files manually by using Windows Explorer or any other File Management program.

To delete the SKI-Pro installation on your computer follow the instruction below:

➢ From the Windows™ Start bar, click Programs.
➢ Select SKI-Pro.
➢ Click Uninstall Leica Geosystems SKI-Pro.
➢ Confirm with Yes. All SKI-Pro files and settings will be removed permanently from the harddisk.
Starting and exiting SKI-Pro

To start SKI-Pro:

- Ensure that the green software protection key (dongle) is inserted into the parallel port of your computer.
- From the Windows™ Start bar, click Programs.
- Select SKI-Pro.
- Click SKI-Pro.

To exit SKI-Pro:

- From the File menu click Exit or click on the X icon of the SKI-Pro main window.
SKI-Pro runs on 32-bit Microsoft® Windows™ 95, 98, 2000 or NT platforms. As SKI-Pro software is based on an intuitive graphical interface with standard Windows™ operating procedures, it is remarkably easy to learn and use. All components have a uniform appearance and interact instantly and seamlessly with each other in a multi-tasking software environment.

Those who are already familiar with Windows™ will find SKI-Pro very easy to handle. Those with no prior knowledge of Windows™ will find it quick and easy to learn.

SKI-Pro consist of several components:

- Project Management
- Coordinate Set Management
- Coordinate System Management
- Antenna Management
- Codelist Management
- Sensor Transfer
- Raw Data Import
- ASCII Import
- ASCII Export
- RINEX Export
- GIS/CAD Export*
- Datum and Map*
- Data Processing*
- Adjustment*
- RINEX Import*

*Some of these components are delivered as options which gives the user the opportunity to select the combination which best suits his or her needs and budget. Refer to chapter 1.2 Software Protection for more information.
The following external programs cannot be accessed from within SKI-Pro but are installed automatically with SKI-Pro:

- Satellite Availability
- Road Line Editor
- Format Manager

These programs are not explained in this manual. Please refer to the corresponding Help Systems of the programs for more information.

**Project Management**

All GPS data that is collected and that belongs together can be organized in SKI-Pro within a single Project. This Project could contain, for example, all data relating to a particular contract you are carrying out for a client.

In the Project Management you can create, open, and edit projects as well as register projects not contained in the project list. The Project Management can also be used to attach and modify Coordinate Systems.

Never delete a project or any of the files contained within a project from outside SKI-Pro. Always use the Project Management to delete unwanted projects. Deletion of projects or project files from outside of SKI-Pro can result in the destruction of the consistency of the database, which will lead to unrecoverable database errors.
Coordinate Set Management

The Coordinate Set Management manages Coordinate Sets that are stored in the SKI-Pro database.

A Coordinate Set is a list of point coordinates that are stored independently from Projects. A Coordinate System may be assigned to a Coordinate Set, allowing you to switch between Cartesian, Geodetic and Grid coordinates.

Points can be added either manually, by importing via ASCII file or by dragging from an existing Project.

A Coordinate Set can either hold WGS84 or Local Coordinates but does not allow to switch between them.

Coordinate System Management

A coordinate system provides the information necessary to convert coordinates to different representations (Cartesian, Geodetic or Grid) and to transform coordinates between the WGS84 and the Local System. A Coordinate System may be attached to a Coordinate Set or to a Project.

Within SKI-Pro the user can work in the global system (WGS84) or in a local coordinate system. The local coordinate system may be a geodetically defined system or it may be a simple grid system with neither an ellipsoid nor a projection associated with it.

The Coordinate System Management is linked to a database that stores the parameters. This database is independent from the project database.
Antenna Management

The Antenna Management allows you to define and edit parameters for different GPS antennas. This information is stored in a global database and can be used to upload to the Sensor or in a Project for Data-Processing. All Leica Geosystems antennas are pre-defined upon installing the software and the user is not permitted to make any changes to these pre-defined antennas.

Codelist Management

A Codelist contains Thematical or Free Coding information that may be assigned to points during measurement in the field. A Codelist may be attached to a Project.

The Codelist Manager enables you to create and edit Codelists for later use in the field.

Sensor Transfer

The Sensor Transfer component allows you to download and upload data from the sensor.

Data can be downloaded or uploaded by a serial cable or directly on to a PCMCIA memory card.

The following data may by downloaded from a sensor:

- GPS Raw Data
- Report files
- ASCII files
- Format Files
- Codelists
- Coordinate System Parameters
- Geoid Model field files
- Antenna definitions
- Configuration Sets

The following data may by uploaded to a sensor:

- Point information
- Coordinate System Parameters
- ASCII files
- Format Files
- Codelists
- Geoid Model field files
- Antenna definitions
- Configuration Sets
- Language Versions
- Firmware
**Raw Data Import**

The Raw Data Import component enables you to import GPS field data into SKI-Pro. It is possible to transfer GPS raw observations for post-processing along with related point information as well as coordinates recorded using the Real-Time RT-SKI option into Projects or Coordinate Sets.

GPS raw observations may be in Leica Geosystems System 200, 300 or 500 format. Optionally GPS raw observations may be imported in RINEX format. See also RINEX Import.

It is also possible to import coordinate files in ASCII format into Projects or Coordinate Sets. Additionally, there is the facility to import Precise Ephemeris data.

**ASCII Import**

The ASCII Import component enables you to import coordinates and baselines from pre-defined or user-defined files. You may import pre-defined files of Leica Geosystems standard format SKI-ASCII or IDEX (InDependent EXchange format).

An import wizard allows to define unknown file formats and enables you to import any kind of user-defined coordinate files.
**SKI-Pro components, continued**

**ASCII Export**

The Export component enables you to export data from SKI-Pro.

Coordinate information may be exported to ASCII files in various pre-defined or user-defined formats.

See also GIS/CAD Export option.

**RINEX Export**

The RINEX Export enables you to export GPS raw observations to an ASCII file in RINEX format. Unlike the RINEX Import this function is not an option and is available as standard.

**GIS/CAD Export (optional)**

The GIS/CAD Export is an optional Export tool. It enables you to write the point coordinates to AutoCAD (DXF/DWG), MicroStation (DGN) or MapInfo (MIF) formatted files.

**Datum and Map (optional)**

If the user requires final coordinate output in the coordinate system to which the GPS measurements are related (WGS84) then this optional tool is not necessary. However, in most cases it is necessary to transform the WGS84 coordinates into a local coordinate system.

The Datum and Map option provides you with a tool to determine transformation parameters which can then be used to perform datum transformations within two sets of coordinates.
**Data Processing (optional)**

The Data Processing is an option that can be accessed via the Data-proc Tab from within a Project window. It allows you to process GPS observations that have been recorded in the field to achieve WGS84 coordinates and their relative accuracy.

Static, Rapid-Static, Stop and Go, Kinematic, Kinematic on the Fly, and Single-Point data can be processed.

The data to be processed may be selected graphically. The computation itself is completely hidden for the user. All selected data is processed automatically in a batch process without the need for any user interaction.

After the Data Processing is completed the results can be viewed and stored for further use in the Results-View.

**Adjustment (optional)**

Adjustment is an option that can be accessed via the Adjustment Tab from within a Project window. It provides you with a powerful tool for performing a least squares adjustment on a network of baseline vectors and terrestrial data (directions, distances, vertical angles and azimuths).

Additionally it enables you to perform a network simulation based upon default observation precisions to find out how good the design of your network is before you measure.

A graphical user interface similar to that of View/Edit allows you to select the points and observations to be adjusted.

**RINEX Import (optional)**

RINEX Import is the optional part of the data Import tool. It enables you to import GPS observation data collected with third party receivers in RINEX (Receiver INdependent EXchange) format.
**Software Navigation Tools**

The various components of SKI-Pro may be accessed using different methods. In order to navigate through the software you may choose the tools which you prefer:
Software Navigation Tools, continued

Menu Bar
The Menu Bar is a special Toolbar at the top of the screen that contains menus such as File, Edit, and View. The Menu Bar lists the available commands. If a command is not applicable it is greyed out and not accessible.

Toolbar
Toolbars allow you to organize the commands you use most often the way you want to, so you can find and use them quickly. You can easily customize toolbars - for example, you can add and remove buttons, create your own custom toolbars, hide or display toolbars, and move toolbars.

List Bar
The List Bar gives you single-click access to all available components and tools of SKI-Pro. Additionally if a Project or a Coordinate Set is open it lists them. Therefore the List Bar allows you to simply switch between a tool and/or a Project or Coordinate Set.

You can display small or large icons, re-arrange them or hide the List Bar.

The List Bar is divided into groups (folders) to help organize your information. Click a folder, e.g. Management, to move to a different set of tasks.

Context Menu
Almost everywhere upon right-click on a particular item in SKI-Pro a Context-Menu is available. A Context-Menu lists all useful commands at a particular instant for a particular item on the screen. It is possible to navigate through the entire software by only using commands from the Context-Menu.

Tabbed-View
Upon opening a Project, tabs at the bottom of the view allow you to quickly switch from one view to another. You may instantly switch from for example the Graphical-View (View/Edit) to the Points-View or Data-processing-View.
Explorer-View

Throughout SKI-Pro a powerful Explorer-View is utilized to list information, be it database information or results from calculations. This view which has similar functionality as the Windows™ Explorer view normally consists of two panes. A Tree-View on the left-hand side and a Report-View or Property-View to the right hand side. Listed data may be easily arranged, sorted, selected and even printed.

Tree-View

The Tree-View pane provides you with an overview of the items you are currently working with, in an expandable/collapsible hierarchy of folders and pages.

Double-click on a folder or click to expand (open) it.

If a folder is open double-click on it or click to collapse (close) it.

Click on a folder or page to display the content of it. Depending on the type of data to be displayed the data will be listed in a Report-View or Property-View.
Views, continued

Report-View

Database information such as e.g. Points or Observations may be listed in a Report View.

<table>
<thead>
<tr>
<th>Point Id</th>
<th>Point Class</th>
<th>Epoch</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>01215</td>
<td>Navigated</td>
<td>12/21/1996 13:43:45</td>
<td>47° 23' 45.73110&quot; N</td>
<td>9° 38' 10.52060&quot; E</td>
<td>446.1217</td>
</tr>
<tr>
<td>01205</td>
<td>Navigated</td>
<td>12/21/1996 14:22:00</td>
<td>47° 23' 51.78132&quot; N</td>
<td>9° 39' 64.09566&quot; E</td>
<td>461.0690</td>
</tr>
<tr>
<td>01219</td>
<td>Navigated</td>
<td>12/21/1996 19:50:00</td>
<td>47° 22' 56.38604&quot; N</td>
<td>9° 39' 36.75722&quot; E</td>
<td>446.0015</td>
</tr>
</tbody>
</table>

Report-View

The data records are listed in rows and columns. Each row displays one record.

The columns are fully user configurable. You can change the width, sort the records according to columns or view and hide individuals columns.

Certain data items may be modified by simply double-click on them.

Property-View

Database information such as e.g. Project Properties may be listed in a Property-View:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sample1</td>
</tr>
<tr>
<td>Location</td>
<td>C:\SKI-Pro\Data\Projects\Sample1\</td>
</tr>
<tr>
<td>Date Created</td>
<td>05/30/2000 13:55:55</td>
</tr>
<tr>
<td>Last Used</td>
<td>05/30/2000 13:55:03</td>
</tr>
<tr>
<td>Avg. Limit Pos.</td>
<td>0.0750</td>
</tr>
<tr>
<td>Avg. Limit Hgt.</td>
<td>0.0750</td>
</tr>
<tr>
<td>Coordinate System</td>
<td>WGS 1984</td>
</tr>
<tr>
<td>Compute Mod. Grid Coordinates</td>
<td>No</td>
</tr>
<tr>
<td>Avg. Combined Factor</td>
<td>1.0000</td>
</tr>
<tr>
<td>Notching Shift</td>
<td>0.0000</td>
</tr>
<tr>
<td>Erasing Shift</td>
<td>0.0000</td>
</tr>
<tr>
<td>Time Zone</td>
<td>1H00</td>
</tr>
<tr>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td>Client</td>
<td></td>
</tr>
<tr>
<td>Sheet</td>
<td></td>
</tr>
<tr>
<td>Map Reference</td>
<td></td>
</tr>
<tr>
<td>Print Header</td>
<td></td>
</tr>
<tr>
<td>Print Footer</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td></td>
</tr>
</tbody>
</table>

Property-View

The information is listed in two columns. The first column lists the description (Property) and the second column lists the actual value.

Property-Views are not user configurable.
Graphical-View

The data contained within a Project may not only be viewed and edited using the Report-View but also using a graphical user interface. Two types of Graphical-Views may be utilised. Points and Baselines are displayed in a map-view while observation data is displayed in a combined Report /Graphical-View.

Both views enable you to select and modify data, zoom in, zoom out and even print the view.

To switch between the different views of a Project simply click on the tabs below the view.
Accessing the On-line Help

The SKI-Pro On-line Help System is a very comprehensive reference and includes all the detailed information about the whole software package.

Any Information NOT contained in this user manual can be found in the On-line Help System.

To display the On-line Help System:

➢ From the Help menu click Contents and Index.

The Help Topics property sheet appears:

All topics contained in the Help are listed in books and pages.

➢ Double-click on a book to open it.
Accessing the On-line Help, continued

A book may contain pages or other books.

- Double-click on a page to open the help text.

To find a topic in the Help:

- Click the Contents tab to browse through topics by category.
- or click the Index tab to see a list of index entries: either type the word you’re looking for or scroll through the list.
- or click the Find tab to search for words or phrases that may be contained in a Help topic.

To print Help text:

- If the Contents tab isn't already displayed, click on Contents.
- Select the book or the page that you want to print.
- Click on the Print button.
- Make sure the printer information is correct.
- Select OK to confirm.

What’s this Help:

Help topics may also be accessed via the controls and commands from the SKI-Pro user interface:

- Click the icon from the Toolbar and click on another Toolbar or List Bar icon or select a command from the menu to open the appropriate help topics.

Alternatively select “What’s This?” from the Help menu.

Glossary of terms:

If you do not understand a particular term used in the software refer to the Glossary of terms contained in the On-line Help System.

- If the Contents tab isn't already displayed, click on Contents.
- Double-click the Getting Help book.
- Double-click the Glossary of Terms page and click on the desired term in the list.

For more information about the On-line Help System refer to Windows™ help by selecting Help from the Start menu.
Quick Tour I - Real Time

This Quick Tour is a step-by-step tutorial in which you learn how to work with real time GPS data. When using real time the processing and the applying of coordinate systems is already done in the field, so that the office work is reduced to importing raw data, eventually checking the results and directly exporting the final grid coordinates.

This exercise does NOT need your green software protection dongle to be connected.

The exercise comprises of the following scenario:

A number of real time points have been measured. Two different reference stations have been used. The points BM1 to BM4 have been measured from both reference stations, all other points from either reference station TP306 or from reference station B215. The raw data is given in the directory:

...\SkiPro\Data\SampleData\Sys500\Realtime.

A local coordinate system has been used in the field, which comprises of a UTM Zone 32 North Projection on the Bessel Ellipsoid and a Classical 3D Transformation called “Sample WGS-Bess“.

Quick Tour I - Real Time

This Quick Tour comprises of the following steps:

Lesson One
- Importing GPS raw data and the attached coordinate system
- Creating the RealTime Fieldbook report
- Creating a Project

Lesson Two
- Exploring the View/Edit component

Lesson Three
- Exporting coordinates to a customized ASCII file
Lesson One - Starting a Project and Importing Raw Data

In Lesson One you will learn how to import GPS raw data and at the same time create a new Project.

Start-up SKI-Pro:

➤ From the Start menu select Programs, SKI-Pro and then click on SKI-Pro.

The main SKI-Pro window appears.

➤ From the Import menu or Toolbar select GPS Raw Data.

or

➤ from the Tools List Bar select Import GPS Raw Data
Lesson One - Starting a Project and Importing Raw Data, continued

The following dialog appears:

- Under **Files of type:** select **GPS500 raw data**.
- Under **Look in:** select the directory that contains the sample data:
  ...\SkiPro\SampleData\Sys500\Realtime\Data\Geodb

Depending where you installed SKI-Pro the path for the sample data may vary slightly. By default SKI-Pro will be installed in:
C:\Program Files\Leica Geosystems\...

- From the browser select the job **RT-Sample**
- Click **Import**.

The following Property Sheet appears:

This is where you can view and modify the raw data.

If you have not yet created any Project, the list of Projects is empty and you can not select an existing Project.

- Right-click on **Projects** and select **New**.
Lesson One - Starting a Project and Importing Raw Data, continued

The following dialog appears and allows you to create a new project while you are still in the Import (Assign) procedure:

- Under **Location** enter a path e.g. `C:\SKIPro\Data\Projects`
  Alternatively you may use the browser.

- Enter a **Project Name** e.g. *RT Sample*. Note that the directory *RT Sample* has been added automatically to the path. This is necessary because a Project consists of several files and each Project shall be stored under a separate directory.

  ➢ **Click OK** to confirm. The New Project Dialog will be closed and a new Project will be created and selected automatically.

Alternatively you can also create a Project using the New Project command from the File menu or Toolbar or via the Project Management of the List Bar.
Back in the Assign dialoge click the **Settings** tab. 

Here you can select the coordinate system, that has been used in the field to be imported into the SKI-Pro Coordinate System Management. Additionally the Coordinate System will be automatically attached to the project to which you assign the data.

- Make sure both options are checked as indicated above.
- Alternatively you can also attach any other coordinate system to the project later.

Click the **Fieldbook** tab to create a fieldbook report.

- Select Coordinate Type **Local** and **Grid** as shown above.
- Click **Preview**... to view the report.
Lesson One - Starting a Project and Importing Raw Data, continued

A GPS Fieldbook Report will be generated and shown in a Report View:

![GPS Fieldbook Report](image)

The GPS Fieldbook Report displays the details of the survey completed in the field.

To scroll through the report use the toolbar buttons ↓ and ↑, or press Ctrl PgDown and Ctrl PgUp.

To print the report click on.

➢ To close the Report View click in the upper right corner.
➢ Click the General tab to return to the General page of the Assign dialog
➢ Select Assign and then Close.

The Project window will open automatically and display the surveyed points in the local grid coordinate system.

Continue with Lesson Two – Exploring the View Edit component.
**Lesson Two – Exploring the View/Edit Component**

In Lesson Two you will learn some useful features of the View Edit component.

The View/Edit project window opens directly in local grid zooming to the full extents including the reference stations.

To get a clearer view you may additionally want to switch off the GPS baseline vectors (the red lines) and switch on the grid lines and the chains (yellow lines) showing how the survey was performed.

Right-click on the background select **Graphical Settings** and change the settings as shown below.

Refer to the Online Help for more information about the other graphical settings.

➢ Use the toolbar button to zoom into the detail points.
The display should now look as follows:

The Point symbols indicate, that the point class is already Measured, as the points were measured in real time in the field. For some points (e.g. BM1) the point symbol indicates, that the point class is Averaged, because these points have been occupied twice. For these two solutions a weighted average is automatically computed.

- Right-click on point BM1 and select Properties. Alternatively you can also double-click on the point symbol.

- If the point is not within the zooming extents, you can use the scroll-to point combobox and the Edit Point toolbar button.

- Click the Mean tab in the property sheet.

The following Property page displays the two solutions and their differences to the weighted average:

- Drag the horizontal scroll bar to the right to display more information.

- Click OK or Cancel to exit the property sheet.
Lesson Three - Exporting Coordinates to a Custom ASCII File

In this Lesson you will learn how to Export coordinates to a customized ASCII file. The Custom ASCII File export type is using a pre-defined format template file (*.frt) to export the data. Format template files can be created using the Leica Geosystems Format Manager program. To complete this exercise a sample format template file (sample.frt) is installed automatically on your computer with SKI-Pro. However if you wish to create your own format template file please refer to Quick Tour III - Format Manager.

You can export coordinates in a variety of other pre-defined formats. Please refer to the On-line Help on Export ASCII and Export GIS/CAD for more information.

While the Project is still open:
- From the Export menu select ASCII,
- or
- from the Tools List Bar or Toolbar select Export ASCII Data.

The following dialog appears:

- Under **Save in** select a path.
- Under **Save as type** select **Custom ASCII File**.
- Enter a **File name** e.g. **RT Sample1** without extension.
- Click on the **Settings** button to change the settings and select the format template file.
Lesson Three - Exporting Coordinates to a Custom ASCII File, continued

The following Property page appears:

To continue, click on the Coordinate System tab.

Make sure the Coordinate System Sample RT is selected. By default the coordinate system attached to the current project is already selected.

Click on OK to close the Settings property page, and finally,

Click Save to write the file to the harddisk.

Change Coord. Class to Main. The coordinate triplets of the highest class will be exported.

Use the browser to select the file

Depending where you installed SKI-Pro the path for the sample file may vary slightly. By default SKI-Pro will be installed in:

C:\Program Files\Leica Geosystems\...
If you open the ASCII file with a Text Editor it will display the following information:

![ASCII file content](image)

**Congratulations!**
You have successfully completed this Quick Tour.
You have learnt how to create a Project, Import GPS real time data including the attached coordinate system, check the data in View/Edit and finally how to export these coordinates to a customized ASCII file.
This Quick Tour is a step-by-step tutorial in which you learn to post-process GPS data from importing raw data to exporting final local Grid coordinates.

This exercise assumes that your green software protection dongle is connected and the two options Data processing and Datum and Map are activated.

The exercise comprises of the following scenario:
A rapid static network has been measured. It consists of the points TP214, B215, TP306, B218 and B313. The whole network has been measured with two receivers only. The raw data is given in the directories:

...\SkiPro\Data\SampleData\Sys500\Static\data1
...\SkiPro\Data\SampleData\Sys500\Static\data2.

The local coordinates of the points B215, B218, B313 are known in UTM Zone 32 North Projection and Bessel Ellipsoid. The coordinates are given in the file:

...\SkiPro\Data\SampleData\Static\Local.txt

The local grid coordinates of the points TP214 and TP306 shall be derived.

This Quick Tour comprises of the following steps:

Lesson One
- Importing GPS raw data
- Creating a Project

Lesson Two
- Modifying reference coordinates
- Processing baselines

Lesson Three
- Creating a Coordinate System

Lesson Four
- Importing an ASCII file with local coordinates

Lesson Five
- Calculating Transformation Parameters

Lesson Six
- Using a Coordinate System with a Project

Lesson Seven
- Exporting Coordinates to an ASCII file
Lesson One - Starting a Project and Importing Raw Data

In Lesson One you will learn how to import GPS raw data and at the same time create a new Project.

Start-up SKI-Pro:

- From the Start menu select Programs, SKI-Pro and then click on SKI-Pro.

The main SKI-Pro window appears.

- From the Import menu or Toolbar select GPS Raw Data.
- or
- from the Tools List Bar select Import GPS Raw Data.
Lesson One - Starting a Project and Importing Raw Data, continued

The following dialog appears:

Under **Files of type**: select **GPS500 raw data**.

Under **Look in**: select the directory that contains the sample data:   ...\SkiPro\Data\SampleData\Sys500\Static

Check **Include subfolders**: all GPS500 raw data in the two sub-directories *data1* and *data2* will be imported in one run.

Depending where you installed SKI-Pro the path for the sample data may vary slightly. By default SKI-Pro will be installed in:

*C:\Program Files\Leica Geosystems* ...

Click **Import**.

The following Property Sheet appears:

This is where you can view and modify the raw data. e.g. to change instrument heights or point id's.

As you have not yet created a Project the list of Projects is empty and you can not select an existing Project.

Right-click on **Projects** and select **New**.
Lesson One - Starting a Project and Importing Raw Data, continued

The following dialog appears and allows you to create a new project while you are still in the Import (Assign) procedure:

Under Location enter a path e.g. C:\SKIPro\Data\Projects. Alternatively you may use the browser ...

Enter a Project Name e.g. PP Sample. Note that the directory PP Sample has been added automatically to the path. This is necessary because a Project consists of several files and each Project shall be stored under a separate directory.

- Click OK to confirm. The New Project Dialog will be closed and a new Project will be created and selected automatically.

Alternatively you can also create a Project using the New Project command from the File menu or Toolbar or via the Project Management of the List Bar.

- Back in the Assign dialog select Assign and then Close.
The Project window will open automatically.

Continue with Lesson Two - Processing Baselines.
Lesson Two - Processing Baselines

In Lesson Two you will learn how to process and store baselines.

The Project window allows you to display the content of a Project by using different tabbed views. Click on the tabs below the window to switch between the different views.

View/Edit shows a graphical representation of each point of the Project.

The Point Symbols indicate that the point class is still Navigated. I.e. the accuracy of the points is low (±100m).

In order to avoid that the results of the baselines are influenced by systematic errors, the coordinates of the first reference point in the network have to be known within about 20m in the WGS84 coordinate system.

This can be achieved by starting the GPS survey on a point with known WGS84 coordinate or by using a Single Point Processing for the starting point of the network.

Please refer to the on-line help on how to perform a Single Point Processing.

In our case we will start the survey on a known point and therefore have to modify the coordinates of our first reference point.

➢ Right-click on point B215 and select Properties.
The Point Property Sheet appears:

- Change the Point Class to **Control**.
- Change the Coordinates to the values below:
  - Latitude: 47° 23' 45.92367 N
  - Longitude: 9° 38' 10.58353 E
  - Height: 429.279 m
- Click **OK** to confirm.

The Point Symbol of point B215 indicates that the point class is now **Control**.

You are now ready to switch to the Data-Processing View and select the baselines to be processed.

- Click the **Data-proc** tab at the bottom of the window.

The following View displays a list of all observation intervals and a graphical representation of the observation time for each interval:
Lesson Two - Processing Baselines, continued

A Baseline is always processed between a Reference point and a Rover point. In the graphical window all observations are represented by horizontal bars which you can select as Reference or Rover.

In our network the point B215 was first used as a Reference and the points TP214, TP306, B313 and B218 have been observed as Rover points.

Afterwards point B218 was used as the Reference and the points TP214, B215 and B313 were observed as Rover.

Finally point B313 was the Reference and TP306 was the Rover.

Therefore to process all baselines we have to make three processing runs.

➢ Right-click on the background of the graphical window, click on Select Mode and then Rover.
- or -
➢ click on Select Mode: Rover from the Toolbar.

The cursor indicates Rover.

➢ Click on the horizontal bars of the first instant of point TP214, TP306, B313 and B218.

The colour of the Rover intervals changes to Green.

To select the Reference point:
➢ Right-click the on horizontal bar of point B215 and select Reference.

The colour of the Reference interval changes to Red.

We are now ready to start the first processing run and process four baselines.

➢ Right-click on the background and select Process or
➢ click on Process from the Toolbar.

A progress indicator will be displayed and the number below indicates which baseline out of the total number is currently being processed.
Lesson Two - Processing Baselines, continued

After the processing run is completed the display will automatically switch to the Results-View allowing you to examine and store the processed baselines:

<table>
<thead>
<tr>
<th>Results</th>
<th>Point Id</th>
<th>Epochs</th>
<th>Signed Status</th>
<th>Ambiguity Status</th>
<th>Baseline</th>
</tr>
</thead>
<tbody>
<tr>
<td>TP23</td>
<td>12/21/1998 14:01:45</td>
<td>no</td>
<td>yes</td>
<td>42567</td>
<td></td>
</tr>
<tr>
<td>TP306</td>
<td>12/21/1998 14:22:00</td>
<td>no</td>
<td>yes</td>
<td>42563</td>
<td></td>
</tr>
<tr>
<td>213</td>
<td>12/21/1998 14:39:00</td>
<td>no</td>
<td>yes</td>
<td>42566</td>
<td></td>
</tr>
<tr>
<td>5210</td>
<td>12/21/1998 14:57:30</td>
<td>no</td>
<td>yes</td>
<td>42568</td>
<td></td>
</tr>
</tbody>
</table>

All Rover points are listed together with its coordinates, quality and the Ambiguity Status. The points for which the Ambiguity Status is yes are selected automatically.

What does Ambiguity Status mean?

The Ambiguity Status is an essential indicator if you want to achieve centimetre level accuracy with short observation times (Rapid Static).

Ambiguity Status yes indicates that the determination of the integer number of cycles between the satellites and the GPS receiver was successful, i.e. the baseline calculation is correct.

Ambiguity Status yes* indicates that the result should be treated with caution.

Ambiguity Status no indicates that the ambiguities could not be resolved.

Ambiguity Status ? indicates that no attempt was made to resolve the ambiguities.

If the Ambiguity Status is no or ? you may further analyse the data by viewing the Logfile. Please refer to the On-line Help for more information about the Logfile.

By default, ambiguities can only be resolved for baselines up to 20 km. For longer distances the ambiguity resolution becomes unreliable. To achieve good results on baselines longer than 20 km you will need to observe for longer periods of time e.g. 1 hour or more.
Lesson Two - Processing Baselines, continued

In our case the Ambiguity Status is **Yes** for all points (baselines) and we can store the coordinates to the database.

- Right-click on the selected points and select **Store** or use the toolbar.

The results of the four baselines are now stored in the database.

- To verify that the baselines have been stored, click the **View/Edit** tab at the bottom of the window.
- Right-click in the background and select **Graphical Settings**... Make sure **GPS** is checked.

The following view is displayed:

To complete the network we have to process the remaining two processing runs.

- To return to the Data-Processing View click the **Data-proc** tab.
- Right-click on the background and click on **Deselect All**.
- Select the second instant of the points **TP214**, **B215**, **B313** as Rover and the point **B218** as Reference.
- **Process** and **Store** the second run.
- Finally, **Select**, **Process** and **Store** the remaining baseline between **B313** and **TP306**.

The following view is displayed:
Lesson Two - Processing Baselines, continued

In View/Edit you will notice that the point symbols have now changed for all points. The point classes are no longer Navigated. Points that have been used as reference points are now awarded the point class Reference. Others have point class Measured or, if they have been measured from two different reference stations, class Averaged.

In a project database there may exist many coordinate triplets for any one point. The coordinate classes represent the hierarchical order of a coordinate triplet. SKI-Pro always displays the coordinate triplet with the highest class for each point as default. For a complete list of all Coordinate Classes refer to the On-line Help.

The points TP214 and TP306 consist of two coordinate triplets of class Measured. From these two coordinate triplets a weighted average is calculated automatically and a new coordinate triplet of class Averaged is displayed.

Right-click on point TP214 and select Properties. Click the Mean tab on the top of the Property Sheet.

The following Property Sheet displays the two solutions and their differences to the weighted average:

- Drag the horizontal scroll bar to the right to display more information.
- Click OK or Cancel to exit the Property Sheet.
Lesson Two - Processing Baselines, continued

To display all point information in a Report-View:
➢ Click the Points tab at the bottom of the window.

The following view is displayed:

<table>
<thead>
<tr>
<th>Point Id</th>
<th>Point Class</th>
<th>Epoch</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>B313</td>
<td>Reference</td>
<td>06/09/2000 08:32:34</td>
<td>47° 22' 58.25553&quot;N</td>
<td>5° 38' 36.56183&quot;E</td>
<td>441.8332</td>
</tr>
<tr>
<td>T214</td>
<td>Averaged</td>
<td>06/09/2000 06:32:34</td>
<td>47° 23' 51.57443&quot;N</td>
<td>5° 37' 11.46874&quot;E</td>
<td>430.1684</td>
</tr>
<tr>
<td>T306</td>
<td>Averaged</td>
<td>06/09/2000 08:32:47</td>
<td>47° 23' 51.50668&quot;N</td>
<td>5° 36' 03.43568&quot;E</td>
<td>431.1832</td>
</tr>
</tbody>
</table>

To change the width of a column:
➢ Drag the right side of a column header as required.
➢ Right-click on any column header and select Auto arrange. All columns will be arranged automatically.

To sort the list:
➢ Click on a column header. The records will be sorted in ascending or descending order according to the selected column.

To display and hide information:
➢ Right-click on a column header and select Hide.
➢ Right-click on any column header, select View and select the required item from the list.

To print the content of the Report-View:
➢ From the File menu or Toolbar select Print.

The print function can be accessed from any view, be it a Graphical-View or a Report-View.

You have now finished the data processing. Five points in the WGS84 coordinate system with centimetre accuracy are now available.

➢ From the Window menu select Close or click the lower x icon in the top right corner.

Continue with Lesson Three - Creating a Coordinate System
Lesson Three - Creating a Coordinate System

In this Lesson you will learn how to create a Coordinate System.

A Coordinate System defines the parameters used to calculate different coordinate representations. If a Coordinate System is attached to a Project or a Coordinate Set it enables you to switch between displaying the coordinates in Cartesian (X,Y,Z), Geodetic (Latitude, Longitude, Height) or Grid (Easting, Northing, Height) format. Additionally if a Transformation is defined you can switch the coordinates of a Project between the WGS84 and a local datum.

What we already know of our Coordinate System is that the local Ellipsoid is Bessel and the Map Projection is UTM32 North. The Transformation is not yet known and has to be determined by using the Datum/Map tool first.

To open the Coordinate System Management:

➢ From the Tools menu or Management List Bar, select Coordinate System Management.

The following Explorer-View appears:

First you have to define the Map Projection:

➢ In the Tree-View right-click on Projection and select New.

The following Property page appears:

➢ Fill in the Property page as above.
➢ Click OK to confirm.
Lesson Three - Creating a Coordinate System, continued

- In the Tree-View right-click on **Coordinate Systems** and select **New**.

The following Property page appears:

![Property page](image)

- Fill in the Property page as above.
- Click **OK** to confirm.
- From the **Window** menu select **Close** or click the lower ☒ icon in the top right corner to close the Coordinate System Management.
In this Lesson you will learn how to import the local control points from a user defined ASCII file and create a Coordinate Set.

- From the **Import** menu click **ASCII data**.
- or
- from the **Tools** List Bar click **Import ASCII Data**

The following dialog appears:

- Choose the file type **Text files**.
- Under **Look in** select the directory that also contains the sample data: `\SkiPro\Data\SampleData\Sys500\Static`
- Select the file **Local.txt**

- Under Coordinate System select **Local**.
- Click **Import**.

This is the first time you are importing an ASCII file of this type. The import Wizard for user defined ASCII files appears automatically, allowing you to define the file format:

The file to be imported is a simple ASCII file. The local coordinates of the points B215, B218 and B313 are separated with spaces and neither a column header nor a keyword is defined.

- Click **Free** and then **Next** to continue.
Check **Space**, the columns will be selected automatically.

Click **Next** to continue.

Right-click on the first column heading (0) and select **Point Id**

Right-click on the second column heading (1) and select **Coordinates** and then **Easting**.

Select **Northing** and **Ell. Height** for the third (2) and fourth (3) column respectively.

Click on **Next** to continue.
The Wizard Step 4 appears:

Click on Finish to close the Wizard.

If you want to import coordinate files of the same type again you can enter a Mask Name and then use this Mask as a Template the next time you import an ASCII file.

You can now assign the points to either a Project or a Coordinate Set. Since these are our control points for the determination of the transformation parameters we will assign them to a Coordinate Set.

➢ Right-click on Coordinate Sets and select New.

The following Property-Sheet appears:

➢ Enter the Coordinate Set Name e.g. PP Sample local.
➢ Select the Coordinate System PP Sample from the list.
➢ Click on OK to confirm.
The Coordinate Set is created and selected automatically:

- Click on Assign and then Close.
- The Coordinate Set will open automatically and display the local coordinates for the points B215, B218 and B313.

- From the Window menu select Close or click the lower icon in the top right corner.
Lesson Five - Calculating Transformation Parameters

In this Lesson you will learn how to use the Datum/Map tool to calculate the transformation parameters.

In order to be able to calculate Transformation parameters we need two sets of coordinates. The first set will be the coordinates of our Project PP Sample in the WGS84 coordinate system. The second set will be the imported local coordinates from the Coordinate Set PP Sample local.

➢ From the Tools menu click Datum/Map.
➢ or
➢ from the Tools List Bar or Toolbar click Datum and Map.

The following view appears:

➢ In the upper Tree-View open the Projects folder and select PP Sample.
➢ In the lower Tree-View open the Coordinate Sets folder and select PP Sample local.
➢ Click on the Match tab to continue.
The following view appears:

The **Classical 3D** is the transformation type that should normally be used when the local Ellipsoid and the Map Projection is known. However SKI-Pro supports a variety of different transformation types. Please refer to the On-line Help for more information.

You can select the common points of system A and system B by selecting them manually or by using the Auto Match command:

- Right-click on the background in one of the views and select **Auto Match**.
- Click the **Results** tab to continue.

The transformation parameters are instantly calculated.

To configure the Transformation type:

- Right-click on the background in one of the views and select Configuration or use the Toolbar button.

- Under **Transformation** select **Classical 3D** and confirm with **OK**.
The following view appears and displays the residuals:

<table>
<thead>
<tr>
<th>System A</th>
<th>System B</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Position/Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>8215</td>
<td>8215</td>
<td>0.0012</td>
<td>-0.0015</td>
<td>0.0008</td>
<td></td>
</tr>
<tr>
<td>8218</td>
<td>8218</td>
<td>0.0014</td>
<td>0.0014</td>
<td>0.0003</td>
<td></td>
</tr>
<tr>
<td>8313</td>
<td>8313</td>
<td>-0.0004</td>
<td>0.0023</td>
<td>0.0000</td>
<td></td>
</tr>
</tbody>
</table>

This view allows you to judge the quality of the transformation. Additionally you may display a **Chart** of the residuals or a **Report** by clicking on the appropriate tabs at the bottom of the window.

- Right-click on the background and select **Store**.

The following dialog allows you to store the transformation parameters, create a new coordinate system based on the coordinate system of **System B** and attach it to the project (**System A**).

- Enter a name e.g. **PP Sample WGS-local**, check ✓ the two boxes and click on **OK** to confirm.

By default the names of the new transformation parameter set and the new coordinate system are the same. You may change the name of the coordinate system if you wish.

The transformation parameters and the new coordinate system are now stored and the new coordinate system is already attached to the project.

Continue with Lesson Six - Using a Coordinate System.
Lesson Six - Using a Coordinate System with a Project

In this Lesson you will learn how to use a Coordinate System with a Project and switch between WGS84 and local coordinates.

If the Project Management is not already open:

- From the Management List Bar, select Project Management.

- Right-click on the Project PP Sample and select Properties.

- Click on the Coordinates tab.

The following dialog appears:

Here you can check that the new Coordinate System is attached to the Project and verify the parameters. Ellipsoid: Bessel, Map Projection: UTM 32 North and Transformation: PP Sample WGS-local should now be displayed.

- Click OK to continue.

- Right-click on the Project PP Sample and select Open.

The Project window opens with the last used View active.

- Select the Points tab.

The view displays WGS 1984 coordinates in Geodetic format:
Lesson Six - Using a Coordinate System with a Project, continued

Since you are now using a Coordinate System with Ellipsoid, Map Projection and Transformation defined, you are able to switch the Coordinate System to Local and change the Coordinate type to Grid.

Using the Coordinate Format Toolbar it is possible to switch between the following different possibilities:

- WGS 1984 Cartesian
- WGS 1984 Geodetic
- Local Cartesian
- Local Geodetic (Bessel Ellipsoid)
- Local Grid (UTM 32 North Projection)

➢ From the Toolbar click on Local and then Grid.

The local grid coordinates of the unknown points TP214 and TP306 are now available.

You may now print the list or continue with Lesson Seven - Exporting local coordinates to an ASCII file.
Lesson Seven - Exporting Coordinates to an ASCII File

In this Lesson you will learn how to Export coordinates to a user defined ASCII file.

You can export coordinates to a variety of other pre-defined formats. Please refer to the On-line Help Export ASCII and Export GIS/CAD for more information.

While the Project is still open:

➢ From the Export menu select ASCII, or
➢ from the Tools List Bar or Toolbar select Export ASCII Data.

The following dialog appears:

➢ Under Save in select a path.
➢ Under Save as type select Text File.
➢ Enter a File name e.g. PP Sample1 without extension.

Since you are using this export type for the first time you have to modify the Settings:

➢ Click on the Settings button to change the export settings.
The following Property page appears:

- Change Coord Type to **Local** and **Grid**.
- Change Coord. Class to **Main**. The coordinate triplets of the highest class will be exported.
- To continue, click on the **Points** tab.

The following Property page appears:

Here you can define the actual point list of the ASCII file. You can select the items to export in the order you want.

- Double-click on **Point Id** then **Easting**, then **Northing** then **Ell. Height**.
- To continue, click on the **Coordinate System** tab.
Lesson Seven - Exporting Coordinates to an ASCII File, continued

- Make sure the **Coordinate System**
  
  **PP Sample WGS-local** is selected.

- Click on **OK** to close the Settings property page, and finally,

- Click **Save** to write the file to the harddisk.

If you open the ASCII file with a Text Editor it will display the following information:

```
| B215 | 548107.88 | 5248990.95 | 476.81 |
| B216 | 546917.88 | 5247905.37 | 479.41 |
| B313 | 548663.81 | 5247524.02 | 489.12 |
| TP214 | 546865.20 | 5249157.70 | 477.70 |
| TP306 | 549213.43 | 5249194.89 | 484.71 |
```

**Congratulations!**

You have successfully completed this Quick Tour. You have learnt how to start a Project, Import GPS raw data, process baselines, determine a transformation, how to derive local Grid coordinates and finally how to export these coordinates to a user-defined ASCII file.
This Quick Tour is a step-by-step tutorial in which you learn how to work with the Leica Geosystems Format Manager program. For further details see the ‘Getting Started with Format Manager’ manual.

The Format Manager is installed as an external program during the SKI-Pro installation. It allows the creation of a Format Template file (*.frt) which can be used within SKI-Pro to export data to a customized ASCII file. Custom ASCII File export is the most flexible ASCII export type.

For more information refer to Quick Tour I - Real Time or the online help of SKI-Pro.

Additionally a Format Template file can be uploaded to the Sensor to convert Jobs to an ASCII file directly on the field system.

This exercise does NOT need your green software protection dongle to be connected.

This Quick Tour comprises of the following steps:

Lesson One
- Creating a Format Template File

Lesson Two
- Uploading a Format Template File to the Sensor

Lesson One - Creating a Format Template File

Start-up the Format Manager:

- From the Start menu select Programs, SKI-Pro and then click on Format Manager.

The main Format Manager window appears.

- From the File menu select New or
- Click on \( \text{ } \) to create a new mask.
The following dialog appears:

- Select Instrument class **GPS500**.
- Click **OK** to confirm.

The workspace displays a tree-view on the left hand side:

To start creating the mask the tree-view has to be expanded.
- Double-click on **Export Formatstrings**, then double-click on **Fixpoint (TPS/GPS)** and finally click on **Exportstring**.

A dialogue appears with the available variables, which can be exported.
Lesson One - Creating a Format Template File, continued

➢ For this example double-click on the following variables:
  Point ID (Target)
  Target (North)
  Target (East)
  Target (Elev)

 Target (Elev) stands for Orthometric Height, in order to export Ellipsoidal Height you have to select Local Ellipsoid Height.

The list is filled automatically and displayed as follows:

<table>
<thead>
<tr>
<th>Point ID (Target)</th>
<th>Target (North)</th>
<th>Target (East)</th>
<th>Target (Elev)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PP123-985123333</td>
<td>5858888888</td>
<td>4140123</td>
<td>8779999999</td>
</tr>
<tr>
<td>1000</td>
<td>2330000000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

➢ To add thematical information change the combo box Datablock-Type to Quality Information (GPS).

➢ Double-click on the following variable:
  3D Coordinate Quality.

The thematical and the quality information shall be written to the second line of each data block.

➢ Move the cursor between the >> << symbols of <<Target (Elev)>> and <<Code ID>> and press ENTER to get a carriage return (new line) after Target (Elev).

➢ Go to the end of the second line and press ENTER to ensure that each data block starts at a new line!

➢ To set the delimiter between the variables click between the >> << symbols of each variable and press the TAB key.

As delimiter you can use any character from the keyboard. Even a combination of several characters is possible.

Quick Tour III - Format Manager
Lesson One - Creating a Format Template File, continued

The display should now look as follows:

![Example Display]

Note, that the lower window changes and shows an example of how your string will look like using dummy values.

At the moment the variables with real numbers contain 10 digits after the decimal point. This formatting can be changed for every variable.

In the upper window double-click on each variable name and change the formatting properties. For this example set the Precision to 3 for Easting, Northing and Elevation, and to 2 for the 3D Coordinate Quality.

Finally from the File menu select Save and enter a name for the format file. The extension (*.FRT) will be added automatically.

Congratulations!
You have learnt how to create a simple customized format mask. Now you can use this format file as an export template either directly on board the sensor or from within SKI-Pro using the Custom ASCII Export.

For the Custom ASCII Export of SKI-Pro please refer to the Quick Tour I - Real Time of this book.

If you want to use the format mask file on the System 500 sensors, proceed with Lesson Two - Uploading a Format Template File to the Sensor.
Lesson Two - Uploading a Format Template File to the Sensor

On the PC:

- **Copy** the file onto your Sensor into the **CONVERT** subdirectory of the PCMCIA card

or

- If you have no PCMCIA slot on your PC, transfer the file to the sensor using the Sensor transfer component of SKI-Pro. In the tree-view **right-click** on **Sensor** and select **Transfer Any File**.

On the Sensor:

- **Select Transfer**, then **GSI/ User File**. Select the **Job** you want to convert, the **Format** file and give a **File** name.

- Note that Format Files need to be stored in the System RAM of the Sensor. Press **FORMT (F3)** to transfer such files from the \CONVERT directory of the PC Card or internal memory to the System RAM or vice versa.

- Under **Destinatn** select **User File**, then the converted file will be written into the DATA directory on the PCMCIA card.

- **FILT (F6)** allows to select a filter and set the sort order.

- **CONT (F1)** to write the file.

For further details please refer to the Technical Reference manual, available as an online PDF-file.

---

Quick Tour III - Format Manager

Getting Started with SKI-Pro -2.0.0en
This Quick Tour is a step-by-step tutorial in which you learn how to export data from SKI-Pro to a GIS or CAD System using the DXF format.

The GIS/CAD Export requires a DXF-header file. A DXF-header file can be created in your CAD package and contains all block and attribute definitions, layer definitions, line styles, drawing extents and other settings needed by your GIS/CAD program in order to convert the DXF file into a drawing file. The DXF header file should be based on your GIS/CAD template file such that it contains all definitions that you work with. For information on how to create a DXF-header file please refer to the documentation of your GIS/CAD software package.

To complete this exercise a DXF-header sample file is already copied to your harddisk with the installation of SKI-Pro.

This exercise assumes that your green software protection dongle is connected and the option GIS/CAD Export is activated.

Before you start with this Quick Tour make sure that you have already imported the real time sample data into SKI-Pro as explained in Quick Tour I - Real Time.
Quick Tour IV - GIS/CAD Export, continued

- Open the Project **RT Sample**, then click on the **Points** tab to display local grid coordinates.

If you start the GIS/CAD Export with no Project open the program will prompt you to select a Project from the list before showing the following dialog:

The following list should be displayed:

![Image of grid coordinates]

- From the **Export** menu select **GIS/CAD...**
  - or
  - Click on ![Points icon] from the Toolbar.

**Under Save as type** select **AutoCAD Files (*.dxf; *.dwg)**.

We now have to create a new Lookup Table. A LookupTable enables you to match thematical codes used in the field with blocks in the DXF-header file. Thus every thematical code can be matched with the required symbol in your CAD/GIS package.
In the **Lookup Table** box right-click and select **New** to create a new lookup table.

Once a lookup table is created it is available for future use.

The following property sheet appears:

![Lookup Table Property Sheet]

- Enter a **Lookup Table Name**.
- To continue click the **AutoCAD Settings** tab.

The following property sheet appears:

- **Template File [*.dxf]**: 
  - Depending where you installed SKI-Pro the path for the sample file may vary slightly. By default SKI-Pro will be installed in: 
    - `C:\Program Files\Leica Geosystems\...`

Use the browser ... to select the file

```
\Shared\Templates\GisCad\Sample_head.dxf
```

Click **OK** to confirm the Lookup Table Settings.

The **Export File** dialog appears again and the **Lookup** button is now active.

- To continue click the **Lookup** button.
On the left hand side is a tree view of the codelist used in the field. On the right hand side you can open boxes for the AutoCAD Layers and Blocks as defined in the DXF-header file. You have to match the thematical codes used in the field with the AutoCad Coding (Layers and Blocks).

Additionally it is possible to match the attributes of each “Leica Geosystems” Code with the attributes as defined for the AutoCAD blocks.

To match the first “Leica Geosystems” Code with the AutoCAD Coding proceed as follows:

- In the Tree-View on the left expand all Layers by clicking on the icons.
- In the Tree-View click on BM and select LAYER1 and BENCHMARK from the combo boxes.
- In the Attributes window right-click, select Add Extra Attribute and then Point Id.
- Right-click again, select AutoCAD Attribute and then POINTID.
- In the same manner match the Extra Attribute Elevation with the AutoCAD Attribute HEIGHT.

The Code BM is now matched!

In the Sample Project the codes do not contain Attributes. Therefore it is only possible to match the default Attributes Point Id and Elevation.
Continue to match the remaining “Leica Geosystems” Codes according to the list below:

<table>
<thead>
<tr>
<th>“Leica Geosystems” Code</th>
<th>Block Symbol and Attributes</th>
<th>AutoCAD Layer</th>
<th>AutoCAD Block</th>
<th>AutoCAD Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLDG (and) HOUS</td>
<td>Point Id Elevation</td>
<td>Layer 2</td>
<td>CROSS_PT</td>
<td>POINTID, HEIGHT</td>
</tr>
<tr>
<td>SHED</td>
<td>Point Id Elevation</td>
<td>Layer 4</td>
<td>MEAS-POINT</td>
<td>POINTID, HEIGHT</td>
</tr>
<tr>
<td>BM</td>
<td>Point Id Elevation</td>
<td>Layer 1</td>
<td>BENCHMARK</td>
<td>POINTID, HEIGHT</td>
</tr>
<tr>
<td>SM</td>
<td>Point Id Elevation</td>
<td>Layer 6</td>
<td>MANHOLE</td>
<td>POINTID, HEIGHT</td>
</tr>
<tr>
<td>EB</td>
<td>Elevation</td>
<td>Layer 3</td>
<td>EDGE_BITUMEN</td>
<td>HEIGHT</td>
</tr>
<tr>
<td>EL</td>
<td>Point Id Elevation</td>
<td>Layer 5</td>
<td>LIGHTPOLE</td>
<td>POINTID, HEIGHT</td>
</tr>
</tbody>
</table>

Table 1: Block definitions of the DXF-header file sample_head.dxf

When all the Codes are matched click OK to confirm.
The following dialog appears again:

The following Property sheet appears:

➢ Change Coord. Class to **Main**. The coordinate triplets of the highest class will be exported.

➢ Make sure the **Coord Type** is set to **Grid** and **Local**.

➢ To continue, click on the **Coordinate System** tab.

➢ Make sure the **Coordinate System** **Sample RT** is selected.

➢ To continue, click on the **AutoCAD** tab. Ensure that the **Format** is set to **DXF** as this is the ASCII format which is supported by most GIS/CAD packages.

The remaining settings do not matter for this exercise.

➢ Click on **OK** to close the Settings property page.
The following dialog appears once again:

Enter a **File name** and ensure the correct path. The extension *.DXF will be added automatically.

and finally,

> Click **Save** to export the file.

**Congratulations!**

You have successfully created a GIS/CAD file in DXF-format.

You can now import the file into your GIS/CAD package. It should then look as follows:
Leica Geosystems AG, Heerbrugg, Switzerland, has been certified as being equipped with a quality system which meets the International Standards of Quality Management and Quality Systems (ISO standard 9001) and Environmental Management Systems (ISO standard 14001).

Total Quality Management-
Our commitment to total customer satisfaction

Ask your local Leica Geosystems agent for more information about our TQM program.